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Overview

ZIP files contain other files.    Typically the files in a ZIP file are compressed.    ZIP files make it
easy to group files and makes transporting and copying these files faster.    ARC files perform
the same function as ZIP files, but use a different file format.    When the term "ZIP file" is 
used in WinZip documentation, it usually also refers to ARC files.    See the section titled ARC 
File Notes for more information.

WinZip(TM) is a ZIP shell for Windows.    It provides an easy-to-use SAA/CUA compliant 
interface for quickly adding, deleting, extracting, viewing, and running files in a ZIP file.    
WinZip also supports ARC files and self-extracting ZIP files.    It    includes a CheckOut feature 
that makes it easy to examine and/or run files in a ZIP file.      An optional interface to virus 
scanning software is provided. The program is easy to install, and extensive online help is 
always available.    All options (including screen size and position) can be saved and restored.

The main WinZip window includes a list of files in the open ZIP file. This list can be scrolled 
and sorted by name, extension, date, or size.    Files can be added, deleted, extracted, or 
viewed using pull-down menu entries and push buttons.    Double clicking on a file opens the 
file with the appropriate application (for example, files with an extension of .WRI are opened 
by the Windows Write application).

The CheckOut facility creates a Program Manager group for all files in a ZIP.      This group 
contains one icon for each file.    Double clicking on an icon runs the appropriate program.    If
the file is executable, it is run.    Otherwise, the file is opened by the appropriate application 
for viewing.

WinZip supports the CUA "object-action process sequence" philosophy. This allows you to 
select objects (for example, files you want to extract or view) and then specify the action 
you want to perform. Alternately, you can use WinZip in a more traditional "action-object" 
style of interaction.

To start WinZip from the Program Manager, double click on the WinZip icon.    To open an 
existing ZIP file from the File Manager, simply double click on the ZIP file.

WinZip requires the Shareware PKZIP/PKUNZIP product from PKWARE, Inc.    It interfaces to 
one of    three programs to access ARC files and optionally runs the SCAN virus scanner from 
McAfee Associates.    WinZip runs these programs in the background in Windows Enhanced 
(80386) mode, or as full-screen applications in Standard and Real modes.    For more 
information on this aspect of the program, see the section titled Enhanced, Standard, and 
Real modes.

WinZip is distributed as Shareware.    This means that users are encouraged, subject to 
restrictions described in the License Agreement, to share copies of this program with friends,
associates and bulletin boards.    Please remember that if you use this software you are 
required to pay the registration fee of $29 as described in the section titled 
Copyright/License Agreement/Warranty.    

This program is produced by a member of the Association of Shareware Professionals (ASP).   
ASP wants to make sure that the shareware principle works for you.    If you are unable to 
resolve a shareware-related problem with an ASP member by contacting the member 
directly, ASP    may be able to help.    The ASP Ombudsman can help you resolve a dispute or 
problem with an ASP member, but does not provide technical support for members' 
products.    Please write to the ASP Ombudsman at P.O. Box 545 Grover Road, Muskegon, MI 
49442 or send a Compuserve message via easyplex to ASP Ombudsman 70007,3536.





PMZIP - An OS/2 Version of WinZip
PMZIP(TM) is an OS/2 Presentation Manager version of WinZip 1.0.    At the time of this 
writing PMZIP does not include the new features in WinZip 2.0 (see the section titled Version 
History for details).    However, PMZIP makes use of some OS/2 features not available under 
Windows, including threads for faster execution, and support for the File Manager drag and 
drop facility.    It also features a file search facility to locate selected ZIP files anywhere on a 
disk.

PMZIP has been available as Shareware since January, 1991, for the same price as WinZip.    
Orders for WinZip placed in 1991 will include a free registered copy of the latest version of 
PMZIP.    Similarly, orders for PMZIP placed in 1991 will include a free registered version of 
the latest version of WinZip.

The shareware version of PMZIP can be downloaded from the IBMOS2 forum on 
CompuServe, the IBM.OS2 conference on BIX, and many OS/2 bulletin board systems.

For ordering information, see the section Ordering Information/Order Form.



Copyright/License/Warranty
For ordering information, see the section Ordering Information/Order Form.
WinZip(TM) Copyright (c) 1991 by Nico Mak - All rights reserved.

License Agreement and Warranty Disclaimer

You should carefully read the following terms and conditions before using this software.    Use
of this software indicates your acceptance of these terms and conditions.    If you do not 
agree with them, do not use the software.

Shareware Version

You are hereby licensed to:    use the Shareware Version of the software for a 21 day 
evaluation period; make as many copies of the Shareware version of this software and 
documentation as you wish; give exact copies of the original Shareware version to anyone; 
and distribute the Shareware version of the software and documentation in its unmodified 
form via electronic means.    There is no charge for any of the above.

You are specifically prohibited from charging, or requesting donations, for any such copies, 
however made; and from distributing the software and/or documentation with other products
(commercial or otherwise) without prior written permission, with one exception: Disk 
Vendors approved by the Association of Shareware Professionals are permitted to 
redistribute WinZip, subject to the conditions in this license, without specific written 
permission.

Unregistered use of WinZip after the 21-day evaluation period is in violation of federal 
copyright laws.

Evaluation and Registration

This is not free software.    This license allows you to use this software for evaluation 
purposes without charge for a period of 21 days.    If you use this software after the 21 day 
evaluation period a registration fee of $29 (plus shipping and handling for orders outside 
USA) is required. Payments must be in US dollars drawn on a US bank, and should be sent to
Nico Mak, P.O.    Box 919, Bristol, CT 06011-0919.    Credit card ordering and quantity 
discounts are available, as described in the section Ordering Information/Order Form.    When
payment is received you will be sent a registered copy of the latest version of WinZip.

One registered copy of WinZip may be dedicated to a single person who uses the software 
on one or more computers or to a single workstation used by multiple people.

You may access the registered version of WinZip through a network, provided that you have 
obtained individual licenses for the software covering all workstations that will access the 
software through the network.

Governing Law

This agreement shall be governed by the laws of the State of Connecticut.

Disclaimer of Warranty

This software and the accompanying files are sold "as is" and without warranties as to 
performance of merchantability or any other warranties whether expressed or implied.    In 
particular, there is no warranty for the optional virus scanning feature (WinZip does not scan



for viruses, it simply runs external programs that claim to perform this function).    Because 
of the various hardware and software environments into which WinZip may be put, no 
warranty of fitness for a particular purpose is offered.

Good data processing procedure dictates that any program be thoroughly tested with non-
critical data before relying on it.    The user must assume the entire risk of using the 
program.    Any liability of the seller will be limited exclusively to product replacement or 
refund of purchase price.



Ordering Information/Order Form
WinZip(TM) 2.00 Registration Form/Invoice.      Please remit to:
                        Nico Mak, P.O. Box 919, Bristol, CT 06011-0919

Ordering by check:    You can order by sending a check and this order form to the address 
above.    To print this order form, click on Print Topic in the File pull-down menu.    Alternately, 
you can print the ASCII text file ORDER.DOC (distributed along with WINZIP).

Credit card ordering:    You can order with MC, Visa, Amex, or Discover from the Public 
(software) Library by calling 1-800-2424-PsL or 713-524-6394 or by FAX to 1-713-524-6398 
or by CIS Email to 71355,470.    These numbers are for orders only.    Any questions about 
refunds, registration options, product details, technical support, volume discounts, dealer 
pricing, site licenses, etc, must be directed to the address above or by CIS Email to Nico Mak
at 70056,241.    You can also mail credit card orders to PsL at P.O.Box 35705, Houston, TX 
77235-5705.

Site licenses: A site license for WinZip entitles an organization to receive one diskette, and 
one copy of the documentation.    For the specified license fee, the organization will be 
entitled to duplicate the diskette and documentation for the specified number of copies.

Please check one: 5.25" Disk ____    3.5" Disk ____ Either size ____

        WinZip individual copy: quantity ___ @ $    29.00 ea. = ___________
        Site license for up to    9 copies:            $ 150.00          = ___________
        Site license for up to 49 copies:            $ 600.00          = ___________
        Site license for up to 99 copies:            $1000.00          = ___________
                (more than 100 copies are negotiable)
        Shipping & handling (OUTSIDE USA ONLY) $    10.00          + ___________
.      Connecticut residents add 8% sales tax                            + ___________
                                                                              Total payment            
___________

Upgrades: To upgrade a registered copy of WinZip 1.0 see the section titled Upgrades.

Payments must be in US dollars drawn on a US bank.    Prices guaranteed through 1991.
Orders received in 1991 will include a free registered copy of the latest version of 
PMZIP(TM).

                          Name:    ___________________________________Date:___________

                    Company:    ___________________________________________________

                    Address:    ___________________________________________________

 City, State, Zip:    ___________________________________Country: _______

                Day Phone:    ____________________    Eve:    _______________________

Electronic Mail address: ______________________________________________

Comments:



Upgrades (WinZip 1.0 to 2.0)
To upgrade a registered copy of WinZip 1.0, send a check for $3.00, along with your name as
it appeared on your WinZip 1.0 order form, to

Nico Mak, PO Box 919, Bristol, CT 06011-0919

Connecticut residents please add 8% sales tax (total $3.24).

You will then receive a disk containing the registered version of WinZip 2.0.

Due to the low price, upgrades will be handled by mail only.



Support and questions
Technical support is available at no charge by sending electronic mail to 70056,241 on 
CompuServe, to Nico_Mak on BIX, or by sending US Mail to Nico Mak, P.O. Box 919, Bristol, 
CT 06011-0919. Registered users have priority but I will try to answer all questions.

When reporting problems with WinZip, please include the following information:

1) Is the problem recreatable?    If so, how?

2) Did the problem occur when running Windows in Enhanced, Standard, or Real mode?    You
can determine which mode is active by choosing About in the Program Manager's Help pull-
down menu.

3) If a dialog box with an error message was displayed, please include the text of the 
message.

Thank you!

Note: You can press F1 at any time while WinZip is active for context sensitive 
help.



Quick start information
Many people that have used other Windows or Presentation Manager applications will be 
able to use WinZip without reading all the documentation. However, the following sections 
should be reviewed before running the program:

 - Copyright/License Agreement/Warranty

 - Installation

 - WinZip Overview

If you've used an earlier version of WinZip, you'll probably want to read the section titled 
Version History for a list of the new features.    In particular, note that the default action 
performed when double clicking on files listed in the main windows has changed.

I also suggest you read the sections titled Hints and Tips and Notes and Background 
Information for miscellaneous information about the interface philosophy and background, 
as well as technical notes.    In addition you might be interested in the section PMZIP - An 
OS/2 PM Version of WinZip.

To learn how to use Help press the F1 key or choose Using Help from the Help menu.



Installation and System Requirements
 System Requirements:

 - Windows 3.0 or later.

 - The PKWARE, Inc.    PKZIP(TM) and PKUNZIP(TM) Shareware programs.    You can download 
these programs from most bulletin boards (the latest version is distributed in the self-
extracting ZIP file PKZ110.EXE), or order them directly from PKWARE (phone 414-352-3670).

- To access ARC files one of the following programs is required:

ARCE.COM and ARC-E.COM - Vern Berg's ARC extraction utility, available on CompuServe 
and other bulletin boards.

PKXARC.COM version 3.5 from PKWARE, Inc.    This program is still available on some bulletin
boards.

ARC.EXE version 5.20 or 6.0 from System Enhancement Associates, Inc.    This is last version
of ARC available as Shareware, and is still available on some bulletin boards.    SEA's 
address is 925 Clifton Ave., Clifton, NJ 07013.

Note: you are likely to encounter problems with earlier versions of these programs.

- You can run the McAfee Associates SCAN.EXE virus scanning utility from within WinZip.    
SCAN is available from CompuServe, BIX, and other bulletin boards. McAfee Associates 
address is 4423 Cheeney Street, Santa Clara, CA 95054.

Note: Like WinZip, the PKZIP, PKUNZIP, ZIP2EXE, ARC, PKXARC, and SCAN programs are not 
free software.    As with all Shareware, if you use these programs you should register them 
with the appropriate vendor.

WinZip-related files are:

 - README.1ST introductory information
 - WINZIP.DOC extracts from online documentation
 - WINZIP.HLP documentation in online hypertext help format
 - WINZIP.EXE required executable
 - WZ.COM required executable
 - WZ.PIF required Program Information File
 - ORDER.DOC order form
 - VENDOR.DOC information for Shareware Distributors and Disk Vendors

Installation:

 Before running WinZip, follow this easy one time installation procedure:

1) If you already have installed a previous version of WinZip, backup and delete all files in 
your WinZip directory.    Otherwise create a directory to hold the WinZip related files.    For 
example, "C:\WINZIP".

2) Copy all WinZip-related files to this directory.    At a minimum you need the following files:  
WINZIP.EXE, WZ.COM, WZ.PIF, and WINZIP.HLP.

3) Run WINZIP.EXE.    If Windows is not loaded, issue the WIN command, and specify the full 



pathname to WINZIP.EXE.    For example, if you copied the WinZip related files into a 
directory named C:\WINZIP, you would issue the following command from the DOS prompt:

WIN C:\WINZIP\WINZIP.EXE

Alternately, if you are already running Windows, simply double click on the WINZIP.EXE entry
in the File Manager.    If you are not familiar with the File Manager, you can instead follow 
these four steps to run WinZip for the first time:

a. Activate the Program Manager.

b. Choose Run... from the File menu.    The Run dialog box appears.

c.    Type the full filename of WINZIP.EXE in the Command Line text box.    For example,
C:\WINZIP\WINZIP.EXE

d.    Choose OK.

That's all there is installing WinZip.    When WinZip is activated for the first time, the 
Welcome and Configuration dialog boxes are automatically displayed, and you are ready to 
go.    Remember that while WinZip is active, online help is always available by pressing F1.

Notes:

1) The first time WinZip is run, it will offer to add a WinZip icon to your Program Manager 
Accessories Group.    Choose Yes in response to this question unless you want to add the icon
yourself (the Accessories Group is merely a default location for the icon - you can drag it to 
any other group like any other Program Manager icon).    Once this is done, you can start 
WinZip by double clicking on the WinZip icon the Program Manager.    Alternately, you can 
open an existing ZIP file from the File Manager by double clicking on the file.

2) WIN.INI associations for files with an extension of "ZIP" and "ZIP" are set up by the 
automatic installation procedure so that you can start WinZip by double clicking on the icons
for these files while running the File Manager.    Also, if you there is no association for .HLP 
files, WinZip sets one up to let you view .HLP files by double clicking on them.



ARC File Notes
Like ZIP files, ARC files contain other files.    Typically the files in an ARC file are compressed.   
The ARC format, developed by System Enhancement Associates, was the first popular PC file
format to support multiple compressed files.    The ARC program was originally distributed as 
Shareware program, and the ARC format was the standard file format on most    bulletin 
board and other online systems.    However, after PKZIP and PKUNZIP were released, the ZIP 
format    become the new standard for many of these systems.    Note: the latest release of 
ARC (version 7) is only sold as a commercial (non-Shareware) program. 

Since there are still many old files in ARC format on bulletin boards, WinZip version 2.0 
includes support for this format.    Since most new files seem to be created in ZIP format, and
there is no single widely available programs to manipulate ARC files, WinZip does not 
provide facilities to update ARC files (all other WinZip functions are supported).      

The latest Shareware version of ARC (version 6) provides limited support for subdirectories.   
However, because individual files cannot be extracted from ARC files containing 
subdirectories and the "extract to" directory cannot be specified, WinZip will not open ARC 
files containing subdirectories.    I expect this limitation will have negligible effect, since I 
have yet to encounter an ARC file containing subdirectories on any BBS.    Let me know if this
causes a problem for you.

WinZip supports three programs to extract files from ARC files: the original ARC, ARCE (also 
known as ARC-E), and PKXARC.    See the    section titled Installation for more information on 
these programs.

ARC files are automatically listed in the Open dialog box if the ARC check box is checked.



Menu Tree
File Menu

New Zip... - open a new Zip file.
Open Zip... - open an existing Zip file.
Close Zip -    close the open Zip file.
Select all - select all files in the Zip
Deselect all - deselect all files in the Zip
Exit - exit WinZip

Actions Menu

Add... - add files to the open Zip file
Delete... - delete files from the open Zip file
Extract... - extract files from the open Zip file
View... - view files in the open Zip file
Virus Scan - run McAfee Associates virus scan against ZIP file contents
Zip2Exe - create a self extracting ZIP File
CheckOut... - examine and/or run programs in a ZIP

Options Menu

Sort by date - sort list of files in open ZIP file
Sort by extension - sort list of files in open ZIP file
Sort by name - sort list of files in open ZIP file
Sort by original order - sort list of files in open ZIP file
Configuration... - modify configuration options
Program Locations... - specify program names and paths
Defaults... - save or restore configuration options
View last output... - view output from the last PKZIP or PKUNZIP command issued by 
WinZip

Help Menu

Help for WinZip - display main help index
Copyright/License Agreement/Warrantee - display license agreement
Ordering information - display order form
Keys help - display keyboard accelerators
Help for help - display instructions for using help system
About WinZip ... - display copyright notice



The File Menu - Opening and Closing ZIP Files
You can create new ZIP files with the New push button or the New entry in WinZip's File pull-
down menu.    You can open existing ZIP files with the Open push button or the Open entry in
WinZip's File pull-down menu.    The Open dialog box is standard, with one exception: there 
are three check boxes at the bottom of the Open dialog box labeled ZIP, ARC, and EXE.    If 
no extension is specified in the edit field at the top of the dialog box, files with the checked 
extensions are listed in the Files list box.

 You can also open a ZIP file listed in the File Manager by double clicking on the ZIP file (this 
starts a new instance of WinZip).

You can close the current ZIP file with the Close entry on the File pull-down menu.    However,
this menu entry is included primarily for completeness, since the New and Open dialog 
boxes automatically perform this action.

The Select all and Deselect all menu entries select and deselect files in the main window's 
list box.    Selected files can be easily deleted, extracted, or viewed.

The Exit menu entry exits (closes) WinZip.



Adding Files to a ZIP File
There are two ways to add files to a ZIP:

1) Click on the Add push button or select the Add entry from the Action pull-down menu to 
bring up the Add dialog box.    Then specify the file names you want to add.    Standard MS-
DOS wildcards are accepted, and multiple file names can be specified.

2) Click on the Add push button or select the Add entry from the Action pull-down menu to 
bring up the Add dialog box.    Then click on the Select Files push button.    This expands the 
Add dialog box.    You can then select files from an Extended Selection List Box.    The 
expanded Add dialog box works much like a standard Windows Open dialog box.

If you would like WinZip to automatically expand the Add dialog box , click on the Unfold 
check box before clicking on the Add button, and save your current settings with the 
Defaults dialog box (available from the Options pull-down menu) before closing WinZip.

The Add dialog box provides the following options:

 - The Add, Freshen, and Update radio buttons correspond to the PKZIP -a, -f, and -u options

 - The "delete original after adding" check box corresponds to the PKZIP -m option

 - The Size and Speed radio buttons correspond to the PKZIP -ex and -es options

 - The "Recurse subdirectories" check box corresponds to the PKZIP -r option

 - The "Store recursed pathnames" check box    corresponds to the PKZIP -p option

 - The "Store specified pathnames" check box corresponds to the PKZIP -P option



Deleting Files from a ZIP File 
There are two ways to delete files from a ZIP:

1) Object-action interface:    first select entries in the list box, then click on the Delete push 
button or select the Delete entry from the Action pull-down menu.

2) Action-object interface:    click on the Delete push button or select the Delete entry from 
the Action pull-down to bring up the Delete dialog box.    You can then specify the file names 
you want to delete (standard MS-DOS wildcards are accepted).

To delete an entire ZIP file click on the Delete push button or select the Delete entry from 
the Action pull-down to bring up the Delete dialog box.    Then select    the "Entire ZIP" radio 
button and click on the "Delete" push button.



Extracting Files from a ZIP File
There are two ways to extract files from a ZIP:

1) Object-action interface:    first select entries in the list box, then click on the Extract push 
button or select the Extract entry from the Action pull-down menu to bring up the Extract 
dialog box.

2) Action-object interface:    click on the Extract push button or select the Extract entry from 
the Action pull-down to bring up the Extract dialog box.    You can then specify the file names
you want to extract (standard MS-DOS wildcards are accepted) or extract all files in the ZIP.

The Extract dialog box lets you specify the directory to contain the extracted files (note: the 
default directory for this prompt can be changed by selecting "Extract Directory..." in the 
Options pull-down menu).

The Extract dialog box provides the following options:

 - The "Overlay newer files only" check box corresponds to the PKUNZIP -n option

 - The "Use pathnames" check box corresponds to the PKUNZIP -d option

Note: the PKUNZIP -o option is always specified.



Viewing Files in a ZIP File
Files can be viewed in one of these ways:

- with the built-in View facility described below
- with the features described in the section titled CheckOut Facility
- most files can be viewed by double clicking on the file name in the main window's list box, 
as described in the section titled Double Clicking

There are three ways to view files in a ZIP file with WinZip's built-in View facility:

1) Object-action interface:    first select entries in the list box, then click on the View push 
button or select the View entry from the Action pull-down menu.

2) Action-object interface:    click on the View push button or select the View entry from the 
Action pull-down to bring up the View dialog box.    You can then specify the file name you 
want to view.

3) Double click on a file name in the main window's list box.    To use this technique you need
to select the appropriate option in the Configuration Dialog Box.

The View dialog box is used to view files in a ZIP file or view the results of the last PKZIP or 
PKUNZIP command issued by WinZip.    Unlike most dialog boxes, the View dialog box is 
sizeable and can be maximized.

If you've selected multiple files for viewing, click on the Next push button to view the next 
selected file.

Click on the Clipboard Copy push button to copy selected text to the system clipboard.    
Note: this button is disabled when no text is selected.

Due to limitations in the standard Windows multi-line edit control, the View facility only 
displays the first 32K of a file.    However, you can use the CheckOut facility to view larger 
files.



Virus Scan
The Virus Scan operation requires the program SCAN.EXE from McAfee Associates.    The 
Virus Scan entry in the Program Locations dialog box must be filled in to use this option.

The Virus Scan operation performs the following actions:

1) Creates a temporary directory

2) Extracts all files in the current ZIP to the temporary directory

3) Runs the McAfee Associates SCAN.EXE program against all files in the temporary directory

4) Deletes all files in the temporary directory and removes the temporary directory

5) Displays the results of the SCAN command in the View window.

Note: SCAN.EXE is not part of WinZip.    It is available separately from McAfee Associates.    
See the McAfee Associates documentation for information on licensing SCAN.EXE.



Zip2Exe - Creating Self Extracting ZIP Files
The Zip2Exe operation converts a ZIP file to a self-extracting ZIP file.    Self-extracting ZIP 
files have an extension of .EXE, and can be run as commands.    When a self-extracting ZIP 
file is run, the files in the ZIP are automatically extracted.    This is convenient, because the 
PKUNZIP command is not needed to extract files from these self-extracting ZIP files.

The Zip2Exe operation runs the ZIP2EXE program.    This program is part of the 
PKZIP/PKUNZIP package from PKWARE, Inc.    If ZIP2EXE.EXE is not in your path, you can use 
the Program Locations dialog box to tell WinZip where to locate it.

You can add, delete, extract, view, and run files in a self-extracting ZIP file with WinZip the 
same way you can manipulate a normal ZIP file.    Self-extracting ZIP files are automatically 
listed in the Open dialog box if the EXE check box is checked.



CheckOut Feature
The CheckOut feature makes it easy to examine and/or run files in a ZIP.    It creates a 
Program Manager Group containing one icon for each file in the ZIP.    Double click on the 
icon to run the file or to view the file with the program associated with the file (associations 
are described in the section titled Windows Associations).

CheckOut Dialog Box

The CheckOut dialog box lets you configure two aspects of the operation:

1) You can specify the temporary CheckOut directory name.    This directory will be created if 
it does not already exist.    Caution: any existing files in this directory will be replaced by files
in the ZIP. 

2) You can specify the maximum number of icons for the Program Manager CheckOut group. 
The Program Manager limits you to 50 entries, but you may prefer a lower number to save 
time.

Operations performed by the CheckOut feature:

When you click on the Ok button in the CheckOut dialog box, WinZip performs the following 
operations:

1) Deletes any existing files in your CheckOut temporary directory.

2) Extracts files in the current ZIP to the temporary CheckOut directory.    

3) If the McAfee Associates SCAN program if it is installed in the Program Locations dialog 
box, it is run against all files in the temporary CheckOut directory.

4) Deletes the Program Manager CheckOut group if it exists.    This ensures that the group 
will only contain entries for the files in the current ZIP.

5) Creates a new Program Manager CheckOut group containing icons for the files in the Zip.   

Using the Program Manager CheckOut Group

The CheckOut Group works like all other Program Manager Groups.    WinZip sets up this 
Group with icons for each file so that you can use them as follows:

1) If a file is executable, double clicking on the icon runs the program.

2) If a file has an association, double clicking on the icon loads the file in the associated 
program so you can view the file.

3) Otherwise, double clicking on the icon loads the file in the WinZip "default association" 
program specified in the Program Locations dialog box.    The default for the "default 
association" program is the Windows NotePad utility, but this can be changed from the 
Program Locations dialog box.



Options
The WinZip option system consists of the following components:

The Option pull-down menu lets you specify whether the list of files in the ZIP file is sorted 
by date, extension, size, name, or whether the original ZIP file order should be used. It also 
lets you bring up the dialog boxes described below.

The Configuration dialog box lets you specify

 - What action is performed when you double click on a file name in the main window's list 
box.    The choices are described in the section titled Double Clicking.

 - Whether the default directory in the Extract dialog box is the current directory or a 
directory of your choice.

- The default current directory when WinZip is started.

 - Whether files in the ZIP file are listed in lowercase for the possibility of improved legibility.

 - Whether WinZip should maintain a log of all error messages and all PKZIP and PKUNZIP 
commands it issues. The log is written to the file C:\WINZIP.LOG.

- The Program Locations dialog box is described in the section titled Program Locations.

The Defaults dialog box lets you save the current defaults for use next time WinZip is 
started, or restore the original distribution defaults.    Options that are saved and restored by 
this procedure include all the options in the "Options" pull-down menu, all options in the 
Add, Configuration, and Extract dialog boxes, and the current screen size and location.

The View last output entry in the Options pull-down displays the results of the last PKZIP or 
PKUNZIP command issued by WinZip.



Program Locations
The Program Locations dialog box allows you to specify the paths and filenames for the 
external programs used by WinZip (these programs are not distributed with WinZip).      When
WinZip is installed it will attempt to locate the default programs in the directories specified 
in your PATH= environment variable.    If it cannot find these programs, it will leave the 
corresponding edit fields blank.

If a program is not installed on your system, just leave the corresponding edit field blank.    
Otherwise, fill in the program name.    The extension defaults to EXE.    If no path is included 
for an entry, WinZip assumes the program is in a directory specified in your PATH= 
environment variable.

The dialog box is divided into the following groups:

ZIP: specify the filenames for the PKWARE, Inc. PKZIP, PKUNZIP, and    ZIP2EXE programs 
here.    

Utilities:    optionally specify the filenames for the following utility programs:

ARC extraction: specify the name of an ARC extraction utility here.    WinZip supports the 
following utilities:

ARC.EXE - version 5.20 or 6.0 of    the original ARC program from System Enhancements 
Associates.

ARCE.COM and ARC-E.COM - Vern Berg's ARC extraction utility.

PKXARC.COM, from PKWARE, Inc. 

Virus scanner: if you use the McAfee Associates SCAN program, specify its name here.

Default association: specify the name of the program that should be used as the association 
for those programs without a WIN.INI association.    The default is NOTEPAD.EXE, the 
Windows NotePad program, but any other file viewer or editor can be used.    For additional 
information, see the section titled Windows Associations.

For information on availability of these programs, see the section titled Installation and 
System Requirements.



Enhanced, Standard, and Real Mode
In Windows Enhanced (386) mode PKZIP, PKUNZIP, ZIP2EXE, and other programs run by 
WinZip are executed in the background in an iconized DOS session.    While these commands
are running you can switch to another window using the Task Manager or by clicking on the 
desired window.    An hourglass pointer is used to indicate that the WinZip window is busy.    
You can double click on the icon titled "WinZip running PKZIP/PKUNZIP" to monitor the 
command's progress.

Unfortunately, it is impossible to execute these commands in the background under 
Standard and Real modes.    In these modes your screen will be cleared, and these 
commands will be run in a full screen DOS session.

In all cases you can view the messages displayed by last command issued by 
WinZip by selecting View Last Output in the Options pull-down menu.

Your Windows 3.00 User's Guide contains descriptions of Enhanced, Standard, and Real 
modes.    You can determine which mode is active by choosing About in the Program 
Manager's Help pull-down menu.



 Using Extended Selection List Boxes
WinZip uses Extended Selection List Boxes for the list of files in a ZIP file and for the list of 
files in the Add dialog box.    You can select files from an Extended Selection List Box the 
same way as you select files in the File Manager, with one important difference: in an 
Extended Selection List Box you can select multiple files by clicking on the first file, and 
while holding down the mouse button, drag over other files you want to select.    

To select an individual file in an Extended Selection List Box, click on the file.    This cancels 
all previous selections.    To select additional files, hold down the Ctrl key while clicking on 
the files.    To select a group of files and cancel all previous selections, click on the first file, 
and while holding down the left mouse button, drag over other files you want to select.    To 
select additional groups of files, hold down the Ctrl key, click on the first file in the group, 
and while holding down the left mouse button, drag over the other files you want to select.    
You can use the "Select all" and "Deselect all" entries in the File pull-down menu to select 
and deselect all files in a ZIP.

The keyboard interface for Extended Selection List Boxes is described in the section titled    
Keyboard usage.



Double Clicking
Depending on a Configuration option, double clicking on a filename listed in the main WinZip
window will perform one of the following actions:

1) The same action performed when you double click on a file in the File Manager.    If the file
is executable (has a filename extension of EXE, COM, BAT, or PIF) WinZip will run it.    
Otherwise WinZip will open the file with the appropriate application.    For example, files with 
a filename extension of .WRI are opened by the Windows Write application.    The appropriate
application is determined via Windows Associations.    If no application is associated with the 
file, WinZip will run the program specified as the default association in the Program 
Locations dialog box.

2) The file is opened by WinZip's built-in View facility.

Note: Pressing the Enter key performs the same action as double clicking.



Windows Associations
Microsoft has defined "associate" as follows: 

To identify a filename extension as belonging to a certain application, so that when you 
open any file with that extension, the correct application is opened automatically.

For example, by default, Windows associates .WRI files with the WRITE application, and .CRD
files with the CARDFILE application.    Most Windows application installation procedures 
create associations.    For example, Word for Windows creates an association for .DOC files.

WinZip uses association when you double click on a filename listed in the main WinZip 
window and when you use the CheckOut Feature.

WinZip, the Program Manager, and the File Manager all use associations the same way. 
When you double click on a file with an association,    the application associated with the file 
is run, and application automatically opens the file.    The WinZip CheckOut facility 
establishes associations when it updates the Program Manager CheckOut group for two 
reasons: to display the right icon for each file, and to ensure that the appropriate application
is run when you double click on an icon,

You can determine the associations for your system by using a program like the Windows 
NotePad program to edit your WIN.INI file (in your Windows directory) and search for the 
section that starts with [Extensions].    You can add associations by adding lines to this 
section of your WIN.INI file.    However, be sure to make a backup of your WIN.INI file before 
making any changes!    Lines you add should be in the following format:

ext=pgm ^.ext

where:

ext is the extension for which you want an association (e.g. CRD)
= is a required equal sign
pgm is the program you want associated with the extension
^ is required (press shift+6 for this key)
.ext is the extension you specified at the beginning of the line

For example, the following line tells the File Manager that when you double click on a file 
with an extension of .HLP the file should be opened by WINHELP.EXE.

HLP=winhelp.exe ^.hlp

Note: you need to restart Windows before changes to your WIN.INI file take effect.

Alternately, you can add extensions using the Associate entry in the File Manager's File pull-
down menu.    To use this technique, start the File Manager and select a filename with the 
extension you want to associate with a program.    Then choose the Associate entry in the 
File Manager's File pull-down menu.    The File Manager will display the Associate dialog box.   
Type the program name in the edit filed and choose OK.    

When entering the program name using either technique, you must supply the extension 
(usually .EXE).    A drive and path are optional.



Error Handling
WinZip does not manipulate ZIP files directly.    Instead it runs the PKZIP command for all 
operations that update ZIP files.    Thus it is highly unlikely that WinZip will ever cause a 
corrupted ZIP file.    If you suspect a corrupted ZIP file, issue following command from a DOS 
prompt:

pkunzip -t filename.ZIP
If PKUNZIP reports that your ZIP file is damaged, try the PKZIPFIX command, as documented 
in section 5 of your PKZIP manual.

When a PKZIP or PKUNZIP command issued by WinZip returns a non-zero error level, a dialog
box is displayed listing the error level and error level description.    Click on the "View last 
output" button to view all messages issued by the command that caused the error.

WinZip will optionally maintain a log of all error messages and all PKZIP and PKUNZIP 
commands it issues. The log is written to the file C:\WINZIP.LOG.

If you encounter errors in WinZip, please report them (see the section Support and questions
for information).



Keyboard usage

WinZip is easier to use with a mouse, but you can also use the standard Windows keyboard 
interface.    Keyboard accelerators defined for WinZip include:

Ctrl+N Open new Zip file.

Ctrl+O Open existing ZIP file.

Ctrl+A Add files to a ZIP file.

Ctrl+D Delete files from a ZIP file.

Ctrl+E Extract files from a ZIP file.

Ctrl+V View files in a ZIP file.

Ctrl+C Activate CheckOut feature

Ctrl+S Run SCAN.EXE (The McAfee Associates virus scan program)

Ctrl+Z Run ZIP2EXE (create self-extracting ZIP file)

Ctrl+Slash (/) Select all items in the list box.

Ctrl+Backslash (\) Cancel the selection of all items in the list box.

Direction key(s) Move the cursor or    scroll to other items in the list box.

Shift+direction keys Select multiple items in list box.
 
Enter    Same as double clicking in the main window listbox.

Shift+F8 Toggle "add mode" on and off.    When add mode is on, you the selection cursor 
blinks.    In this mode you can use the Spacebar to select nonconsecutive items in the list box
or to cancel the selections.    Press Shift-F8 again to end add mode.



Ideas for future enhancements

Ideals for future enhancements include:

 - Support for other file formats (e.g. ZOO and LHZ)

 - Support for all ZIP options, including passwords and comments

 - Optional hex and ASCII    dump mode when viewing files in a ZIP file

 Additional suggestions from all users are welcome!



Hints and Tips
Here are a couple hints and tips you may find useful:

1) If you usually download files to the same directory, specify that directory as the "Default 
current directory" in the Configuration dialog box, so that WinZip starts up in that directory.   
To save your self the trouble (and time) of clicking on the Open button or selecting Open 
from the File pull-down menu, check the "Automatically show Open dialog box" button, also 
in the Configuration dialog box.    Don't forget to save your configuration in the Defaults 
dialog box (available via the Options pull-down menu).

2) To select multiple discontigious files in the main WinZip list box, see the section titled 
Using Extended Selection List Boxes.

3) Don't drag icons from the CheckOut Program Manager Group to other groups if you are 
planning to delete the CheckOut directory.    The icons will point to the empty directory, and 
will be useless.

4) To switch to another program while WinZip is executing a DOS command, click on the 
window for the other program, or bring up the Task Manager by double clicking over the 
desktop or pressing Ctrl+Esc.    Note: you can't use the WinZip system menu or minimize 
button while WinZip is executing a DOS command.

5) You can change the default WinZip icon in Windows 3.0 as follows:

a. Open the Program Manager group window for the group containing WinZip.

b. Choose Program Properties from the File menu.    The Program Item Properties dialog box
appears.

c. Click on Change Icon.    The Select Icon dialog box appears.

d. Click on View Next to cycle through the icons.    Choose OK when your preferred icon 
appears.

e.    Choose OK.



Notes and Background Information
 - This version of WinZip was tested under Windows 3.00 with the following programs:

PKZIP, PKUNZIP, and ZIP2EXE versions 1.1 from PKWARE, Inc.    (PKZIP and PKUNZIP are 
registered trademarks of PKWARE,    Inc.)

ARC.EXE version 5.20 and 6.0 from System Enhancement Associates, Inc.

ARCE.COM version 4.0e from Vern Berg

PKXARC.COM version 3.5 from PKWARE, Inc.

SCAN.EXE version 7.2V77 from McAfee Associates

- There is a bug in Windows 3.0 that can cause Windows to crash if you try to update a read-
only disk.    This can occur if you attempt to update a ZIP file on a read-only disk with WinZip.
Microsoft Online technical support has stated that this is a known problem, and that no 
workarounds are available for Windows 3.00.    You can demonstrate this problem in 
Enhanced mode without WinZip as follows (be sure to save your files first):

- Start a DOS session from the Program Manager.
- Try to delete a file on a read-only disk.    Reply Abort or Fail to the critical error message.
- Exit the DOS session.
- Try to access the read-only file from a Windows application (e.g. Notepad).

At this point Windows typically locks up or terminates.

 - WinZip supports most commonly used PKZIP and PKUNZIP options but the current version 
does not include special support for comments, passwords, and file attribute masks.

 - WinZip uses temporary disk files to communicate with WZ.COM and the PKWARE, Inc. 
programs.    WinZip uses a unique filenames for these files, and automatically erases them 
when they are no longer needed.    WinZip determines which disk to use by checking the 
value of the WZTMP=, TMP=, TEMP=, and PKTMP= environment variables.    If none of these 
environment variables is set WinZip uses the root directory of your C: drive.

- WZ.COM is used for two reasons: to obtain the error level (return code) from the PKZIP and 
PKUNZIP commands, and to capture the output from these commands for use by the "View 
last output" entry in the Options pull-down menu, 

 - WinZip is a Windows version of PMZIP.    I wrote PMZIP because I wanted an OS/2 
Presentation Manager    interface to ZIP files, and no other programs provided this facility.    
The first version was written in Digitalk's Smalltalk V/PM.    The result, like all V/PM programs,
required over a megabyte of code to execute, and was rather slow.    Favorable response to 
the first version convinced me to rewrite the program in C and release it as Shareware.    I 
subsequently rewrote it for Windows, and this is the result.

- Special thanks to Steve Queen for his    feedback on the WinZip user interface.



Version History

The following changes were made in WinZip 2.00:

- Double clicking on a file now has the same effect as double clicking in the File Manager.    
This behavior can be altered with a Configuration option.

- Added CheckOut facility

- Added support for ARC Files

- Added optional interface to Virus Scan software

- Added support for self-extracting ZIP files (ZIP2EXE)

- Added Program Locations dialog box

- Added option to delete an entire ZIP in the Delete dialog box

- Added separate sorted list boxes for filenames and directories in the Open dialog box

- Added list box containing directories in the New dialog box

- Added a "default current directory" configuration option (see the first item in the Hints and 
Tips section for a description of why this can be useful).

- Added keyboard mnemonics for controls in all dialog boxes

- Moved push buttons to a button bar on top of the main window, and added the New, Open, 
and CheckOut buttons

- Temporary files are cleaned up sooner

The following changes were made in WinZip version 1.00A:

- Fixed bugs which caused errors accessing WinZip temporary files under certain 
circumstances

- Check for maximum command line length of 127 (instead of 128)

- Double clicks on WinZip windows are ignored while PKZIP is running

- Reworded text in File/New dialog box



Missing file(s)
A required file was not found.

PKZIP.EXE and PKUNZIP.EXE must both be in your path.    Also, WINZIP.HLP and WZ.COM must
both be in the same directory as WINZIP.EXE.    The Installation section describes the 
complete installation procedure.



Invalid ZIP File
This dialog box is displayed if WinZip was unable to open the specified ZIP file, read the ZIP 
file directory, or if a fileid is invalid.    It is possible that the file is not a ZIP file.    Alternately, 
it is possible that the ZIP file has been corrupted.    For more information, see the section 
titled Error Handling.



Add files selected in list box?
This dialog box is displayed if you've updated the edit field in the expanded Add dialog box 
after selecting files from the list box.    WinZip isn't sure whether you want to add the 
selected files or add the files that match the names specified in the text field.    To add the 
selected files click on the OK button.    



This dialog box is displayed when an unexpected WinZip internal error occurs.    Please 
contact the author with as much information about the error as possible.    For a list of 
contact points, choose About from WinZip's Help pull-down menu.



This dialog box is displayed when a required edit field is empty.    For example, it is displayed 
if you don't specify which file you want to open in the Open dialog box.    Specify the required
information and try again.



This dialog box is displayed if you click on the Add button in the expanded Add dialog box 
but haven't selected any files to add.    Select one or more files in the file list box, or click on 
the Cancel button.



To view a file, WinZip normally extracts the file to disk, reads it, and erases the temporary 
disk file.    WinZip determines which disk to extract to by checking the value of the WZTMP=, 
TMP=, TEMP=, and PKTMP= environment variables.    If none of these environment variables 
is set it extracts to the root directory of your C: drive.

The message The disk file "fileid" already exists.    Should WinZip overwrite it so that the file 
in the ZIP can be viewed? is issued if a file with the requested name already exists on disk.    
If you choose Yes, the existing disk file will be overwritten, and processing will continue.    If 
you select No, WinZip will abort the view operation for this file.



This dialog box is displayed if WinZip cannot display the entire file you are viewing because 
it contains binary zeros.    WinZip uses a standard multi-line edit field to display files, and 
these controls truncate text at the first binary zero.



This dialog box is displayed if you try to open a ZIP with a directory too large for WinZip to 
handle.      You will not be able to open the ZIP file with this version of WinZip.



This dialog box is displayed if    a PKZIP or PKUNZIP command is over 127 characters long 
(the longest command allowed under MS-DOS is 127 characters).    The total command line 
length includes several components used internally by WinZip in addition to the PKZIP or 
PKUNZIP command.    There are a couple ways to reduce the length of the command line:

1) Move WINZIP.EXE (and the related files) to a directory near the root directory (for 
example, a directory like C:\WINZIP is better than C:\WINDOWS\UTILITIES\SHAREWARE\
WINZIP).

2)    Move the ZIP file you are working with to a directory near the root directory.

3) If you are adding, deleting, extracting, or viewing multiple files at one time, specify them 
via a listbox rather than an edit field.    This causes WinZip to create a PKZIP/PKUNZIP 
response file, which usually takes less room on the command line than multiple file names.



Selected Text Successfully Copied To Clipboard

This dialog is displayed to let you know the text selected in the View dialog box has been 
copied to the system clipboard.    You can paste the text into another application (for 
example, Notepad) by choosing Paste from the application's Edit pull-down menu.



This dialog box is displayed when WinZip could not create a required temporary file on the    
disk drive listed in the dialog box.    Possible causes are that the disk drive is invalid, or that 
the root directory of the disk is full.

WinZip determines which disk to use for temporary files by checking the values of the 
WZTMP=, TMP=, TEMP=, and PKTMP= environment variables.    If none of these environment
variables is set, WinZip creates temporary files on your C: drive.



The program required to perform the function you selected was not installed in the WinZip 
Program Locations dialog box.    For example, to extract files from an ARC file, you need to 
have specified an ARC extraction program.    This message is issued if you try to extract files 
from an ARC but did not specify an ARC extraction program.



WinZip can't find one of the programs you specified in the Program Locations dialog box.    If 
you specified a directory (for example, you entered C:\UTILITY\PKZIP.EXE), then WinZip can't 
find the program in that directory.    If you did not specify a directory (for example, you 
entered PKZIP.EXE) then WinZip can't find the program in any of the directories specified by 
your PATH= environment variable.    

Note: if you update your PATH= statement, the changes will not take effect until you leave 
Windows and restart Windows.



WinZip does not recognize the name of one of the programs you entered.    For example, you
will get this message if you specify ZIPPER.EXE as the name for PKZIP.EXE.    WinZip lets you 
specify the drive and directory containing the program, but does not support the use of 
unrecognized file names for these programs.



Your ARC extraction program returned a non-zero error level.    Consult the documentation for
your ARC extraction program for the meaning of the error, and/or use the View Last Output 
entry in the Options pull-down menu to check for error messages issued by the ARC 
extraction program.    

Note: one likely cause for this error is using an old version of the ARC extraction program.    
See Requirements section of the documentation for version information.



This dialog box is displayed to give you a chance to confirm that you really want to delete 
the entire ZIP.    Select No to abort the operation or Yes to delete the ZIP.



This dialog box is displayed to give you a chance to have WinZip delete the temporary 
CheckOut directory and the Program Manager CheckOut group.    Select Yes to delete these 
items before closing WinZip.    Select No to close WinZip without deleting these items.    
Select Cancel to cancel the close operation.



WinZip version 2.0 (the version you are now running) was coded for Windows 3.0 and 
detected that you are running a later version of Windows.    You should have no problems 
running WinZip under this release of Windows.    However, an enhanced version of WinZip is 
planned for release at the same time as Windows 3.1.    This new version will support the 
drag and drop interface, the Windows 3.1 common dialogs, and other new features.    For 
information about obtaining the latest version of WinZip, please contact your distributor, the 
author, or check the WINADV forum on CompuServe or the IBM.WINDOWS forum on BIX.

This dialog box will not be displayed again.



This dialog box is displayed when WinZip cannot run a program.    This can happen when a 
program specified as a Windows Association was deleted from your system or was moved to 
a different drive or directory.    The following are the error codes Microsoft has documented:

Value Meaning

0 Out of memory. 
2 File not found. 
3 Path not found. 
5 Attempt to dynamically link to a task. 
6 Library requires separate data segments for each task. 
8 Insufficient memory to start application. 
10 Incorrect Windows version. 
11 Invalid .EXE file (non-Windows .EXE or error in .EXE image). 
12 OS/2 application. 
13 DOS 4.0 application. 
14 Unknown .EXE type. 
15 Attempt in protected (standard or 386 enhanced) mode to load an .EXE created for 
an earlier version of Windows. 
16 Attempt to load a second instance of an .EXE containing multiple, writeable data 
segments. 
17 Attempt in large-frame EMS mode to load a second instance of an application that 
links to certain nonshareable DLLs already in use. 
18 Attempt in real mode to load an application marked for protected mode only. 


